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LEARNING

In this chapter, you will learn about :
© Whatis Hardware? ©  What is Software?

A computer system is made up of two parts— Hardware and Software.

WHAT IS HARDWARE?

The physical parts of the computer that we can touch or feel are
called hardware. There are some computer parts such as the
keyboard, mouse and monitor which you can see. However, there are
some other components of computer which we cannot see. They are
present inside the CPU box.

The hardware components that make a computer system are as
follows :

© Input devices
@  Qutput devices
©  Components inside the CPU box

Input Devices

These devices help to enter data into the computer. Some of the
common input devices are as follows :

Keyboard : A keyboard is the most
commonly used input device. We can
enter or type data and instructions
into the computer by pressing various |
keys on the keyboard. The letters on
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the keyboard are unorganised. The keyboards generally used are also
known as QWERTY keyboards. The keys on the keyboard are broadly
divided into the following groups :

©  Alphabet keys ©  Number keys @  Special keys
©  Function keys @  Navigation keys

Mouse : Mouse is also a commonly used
input device. It is used to select and open
things on a computer with the help of a
mouse pointer. As we move the mouse, the
pointer also moves in the same direction. A
mouse has two or more buttons that perform
different functions. We can perform four different actions using a
computer mouse.

©  Single-click ©  Double-click
o  Right-click © Drag and drop

Scanner : A scanner reads images, pictures, documents, etc. directly
and gives the same as input to the computer. There are various types
of scanners.

Flatbed Sheet-fed Drum Handheld
scanner scanner scanner scanner scanner

Trackball : A trackball can be used in place of
a mouse. It is similar to a mouse. It has a
ball on its top which is rolled by fingers to
move the cursor around the screen. A track
ball requires less space than a mouse for
operation because the whole device is not
moved for moving the cursor.
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Microphone : A microphone is used to input sound
into a computer. It helps in -
recording our voice or other
sounds.

Joystick : A joystick is used to
move objects or a pointer on
the screen. Joysticks are
popularly used for playing video games.

Light Pen : A light pen is used for drawing
images and selecting objects on the display
screen by directly pointing to the objects with
the pen. It is mostly used Dby engineers,
architects, designers, etc. It is used to select an
option on the screen by simply pointing at it.

BCR : BCR stands for Barcode Reader. It is used
to read barcodes. A barcode is a set of lines of
different thicknesses that represent a number. A -
barcode reader recognizes the information from

the thickness and spacing of bars and sends the
information into the computer system.
Nowadays, we find barcodes on many products.

[

Fact KnOW ) Local Knowledge

An Optical Mark Reader (OMR) is an input device which read marks made by pencll
on a printed form and transfers these into a computer.

MICR : MICR stands for Magnetic Ink
Character Recognition. It is used by the
banking industry for faster processing of the
large volume of cheques. The number codes
at the bottom of the cheques are written
using a special ink called magnetic ink.
MICRs are used to read these characters.
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Output Devices

These devices show the result after computer completes the work.
Some of the common output devices are as follows :

Monitor : A monitor is the most commonly used output device. It is
known as the VDU (Visual Display Unit). It is similar to a TV screen and
can display both text and pictures. The images that we see on a monitor
are made up of tiny dots called pixels. The image’s clarity depends on
the number of dots on the screen. The output that we get on a monitor
is called soft copy. There are three types of monitors. They are :

Cathode Ray Tube Liquid Crystal Display Light Emitted Diode
(CRT) (LCD) (LED)

Printer : A printer transfers the information that you see on a monitor
onto a paper. The printed information on the paper is called the printout.
The output given by a printer is also known as hard copy. Some printers
can print only in black and white while others can print in any colour.
Printers can be classified into two broad categories :

Impact printers and non-impact printers. 47
e

©  Impact Printers : It is a printing device in which \{,’
the printing surface strikes the paper. These \w «
printers are slow, noisy and are not used for 5
high-quality printing. Ball printers and dot-
matrix printers are examples of impact printers.

©  Non-impact Printers : It is a printing device in
which the images are created without being
struck onto the paper and hence generate less

Dot-matrix Printer

Laser Printer
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noise. These printers are faster than impact printers. Laser
printers and inkjet printers are examples of non-impact printers.

*r—

Fact IGDOW _ Local Knowledge

The printing speed of the printer is measured in CPS, i.e. Character Per Second or
PPM, i.e. Pages Per Minute.

Speakers : Speakers are used to play music and sound on a computer.

Headphones : The headphones are known as earphones. They are
used to listen to sound or music from a computer without disturbing
other people.

Plotter : A plotter is a special type of printer used for producing high
quality graphs or diagrams. Plotters are used by engineers, architects
and map-makers to print plans of buildings, etc.

Projector : Projector displays the output on a screen. It uses whiteboard,
a white cloth or even a plain white wall as a screen to show output. It is
used for teaching, giving presentations, etc.

Components Inside a CPU Box
The various components present inside a CPU box are as follows :

Motherboard Processor or CPU

It is the main board. It It is the brain of the computer. It processes the
allows all the parts to data and instructions given by the input devices,
receive  power and then it sends the result of processing to the output
communicate with one devices. It is present on the motherboard.

another.

T swes Vermory Chips

SMPS stands for Switched Memory chips are one of the important
Mode Power Supply. It components of computer hardware. There are
converts the incoming two types of memory chips present on the
electricity into proper voltage motherboard RAM and ROM. This component of
and supplies it to other parts the CPU stores data and information permanently
present inside the CPU box.  or temporarily while working on the computer.
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_____ DiskDrives M@ Pots

The disk drives in a computer are  Ports are used to plug various devices
the devices that let you store and  such as the mouse, keyboard or printer to
retrieve data and applications on  the computer system. These days, most of
and from storage devices such as  the devices are connected to the computer
the hard disk, CD and DVD. through USB (Universal Serial Bus) ports.

WHAT IS SOFTWARE?

A computer is just a machine. The hardware components cannot do
anything by themselves. So, instructions have to be given to the
computer to get some work done by it. A group of instructions given to
the computer to make it work is called software.

Unlike hardware, we cannot see or touch the software.

Different types of software are used for different types of work.
Software can be classified into the following categories :

System Software

System software is a collection of programs that controls the overall
operation and working of the computer system. It can be classified
into three categories : Operating System, Language Processors and
Utility Software.

1. Operating system : It controls the overall
activities of a computer. It acts as an interface
between the user and the hardware and enables
them to work together. Various types of operating
systems are Windows, UNIX, LINUX, Mac, etc.

Functions of an Operating System

The main functions of an operating system are :

@ |t controls the working of all input and output (I/O) devices.

© |t provides security by means of passwords to prevent misuse of a
computer.
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© |t lets us create and manage files and folders for storing
information in a computer efficiently.

© |t allocates memory to various programs whenever required. It
also frees the memory when it is not in use.

2. Language processor : Software is written by computer programmers
using computer languages. There are many computer languages such
as C, C++ and Java. The programs written in these languages cannot
be directly understood by a computer.

A computer is an electronic device which can understand only the
machine language which consists of O’s and 1’s.

A language processor converts a program written in a computer
language into the machine language so that it can be understood by a
computer.

There are three types of language processors namely :
©  Assembler © Interpreter o  Compiler

3. Utility software : The primary job of utility software is to perform
maintenance on a computer system in order to ensure its smooth
functioning.

Some of the examples of utility software are Disk Cleanup and
Antivirus software.

Application Software

Application software is a set of programs, developed by programmers
in order to perform specific tasks. They may be installed on a
computer depending upon the user's requirements. Application
software can further be divided into two categories : General Purpose
Application Software and Specific Purpose Application Software.

1. General purpose application software : General purpose application
software is developed keeping in mind the general needs of a large
number of people. Some of the examples of such software are :
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Word Processing software : This software helps
us to create text-based documents like letters, W"‘ i
stories, essays, etc. We can edit, format and ' —

print the text and graphics in a document. Examples of word
processing software are MS Word, OpenOffice.org Writer, etc.

Spreadsheet software : This software helps us

to perform calculations and analyze data in the (g
desired manner. Examples of spreadsheet ‘{“‘; E
software are MS Excel, OpenOffice.org Calc, etc. =

Presentation software : It is used to present an idea or concept
lively. This software helps us to create and display slides on a
computer for educational and business .

purposes. Examples of presentation software are IPE“' F
MS PowerPoint, OpenOffice.org Impress. S O

DBMS : DBMS stands for Database Management System. This
software helps us to arrange and store a large amount of information

in an organised way. Examples of ——
DBMS software are MS Access, ‘E'
Oracle, OpenOffice.org Base, etc. | 8

DTP : DTP stands for Desktop Publishing. This
software is used for creating designs and layouts |
of books, newspapers, brochures, magazines, etc.

Examples of DTP softwares are Adobe Indesign, Quark
QuarkXPress, etc.

Graphics software : This software allows us to (-
create and edit images. Examples of graphics
software are Adobe Photoshop, CorelDraw, etc.

Multimedia software : This software lets us combine -

P

\ 4

CorelDRAW

images, text, sound, animations and videos to create an
interactive software. An example of multimedia software
is Adobe Flash.
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2. Specific purpose application software : Specific purpose application
software is called customised software. This type of software is
developed keeping in mind the specific requirements of an organisation
or an individual. Examples of this type of software are billing systems
used in supermarkets, reservation systems used in airports and railway
stations, payroll systems and stock systems used by organisations, etc.

O & © O

Jgaco@@act the

Hardware means the physical parts of the computer that you can touch or feel.

The devices through which we enter data and instructions into the computer are called input devices.
The devices through which we get the output from a computer are called output devices.

The various components present inside a CPU box are : motherboard, processor or CPU, SMPS,

ports, disk drives and memory chips.

©  Software is a set of instructions that tells a computer how to perform a specific task. Software is
also referred to as a set of programs. Software is necessary to make the computer hardware work.

A. Tick (V) the correct answer :

L.

Which of the following is not an output device?

(a) Graphic Tablet (b) Plotter (c) Printer
software helps us to create text-based documents.

(a) Presentation (b) Word Processing (c) DBMS

Which of the following is not an input device?

(a) BCR (b) Biometric sensor (c) Projector

Which of the following components present inside the CPU allows
all the parts to receive power and communicate with one another?

(a) Processor (b) Motherboard (c) Ports
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B. Write ‘T’ for true and ‘F’ for false in the given circles :
1. Plotters are used by engineers, architects and map-makers to

print plans of buildings, etc.

2. Software means the physical parts of the computer that we can

touch or feel.

3. SMPS processes the data and instructions given by the input
devices, then it sends the result of processing to the output devices.

4. BCR is used by the banking industry for faster processing of the

large volume of cheques.
C. Fill in the blanks :

1. is a set of instructions that tells a computer how to
perform a specific task.

2. A can be used in place of a mouse.

3. converts the incoming electricity into proper voltage
and supplies it to other parts present inside the CPU box.

4. A Is a special type of printer used for producing high

quality graphs or diagrams.

D. Answer the following questions :

1. State the difference between impact and non-impact printers.

2.  What is the role of ports and SMPS inside the CPU of a computer system?
3. What do you mean by language processor?

4. What is the difference between hardware and software?

Creativity Skills | dl

*-—

Art Integration

Draw and colour any two icons of Word Processing software in the given space :

4 )

N J

4 )
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Prepare a list of software installed in your computer at home. Classify them as
system software and application software. Further, classify the application
software as general purpose application software and specific purpose
application software.

Experience-based Questions Higher Order Thinking Skills

1. Tanu wants to plug the mouse and the keyboard to her computer system.
Which component of the CPU box will she use to connect them?

2. Aarohi works in a publishing company. She creates designs and layouts of
books. Which software is used by her?

*—

Think & Answer Life Skills & Values

If one of your friend is pulling the wires of the mouse then what will you do?

Activity Work Cutting & Making Skills

1. Prepare a collage on ‘Hardware components that make up a computer
system’.
2. Prepare a project file on ‘Computer Software’.

[ S—

_DiSCUSSiOh Communication

Find out how webcam made the conversations more interesting. Discuss in
class.

Teacher's Help
©  Demonstrate the uses of hardware components available in the computer lab to students.

© The teacher should explain to the students the concept of software by giving suitable examples of the programs
used on a computer.
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" 2 Windows 10
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LEARNING

In this chapter, you will learn about :

© Qperating System ©  Versions of MS Windows
© Features of Windows 10 o Starting Windows 10
O Desktop ©  Components of a Desktop

OPERATING SYSTEM

An operating system is a very important part of a computer. A
computer is of no use without an operating system. It is a software
that tells a computer how to work. It controls the working of different
hardware devices attached to the computer and also keeps a record of
all the programs onto which you work.

Microsoft Windows, Linux and Macintosh OS are some of the
examples of operating system.

VERSIONS OF MS WINDOWS

MS Windows has many versions. Some of the
popular versions of Windows are Windows 98,
Windows XP Windows Vista, Windows 7,
Windows 8, Windows 10 and Windows 11.
Windows 11 is the latest version of Windows. Windows 10
We will learn Windows 10 in this chapter.

FEATURES OF WINDOWS 10
The features of Windows 10 are as follows :
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© The Start Menu was removed from the desktop in Windows 8,
but it is back in Windows 10.

o It includes the best features of Windows 7 and Windows 8.

©  Windows 10 comes with great built-in Store that helps you stay
In touch, and it has many apps, songs, games and entertainment
than ever before—many free.

© It is more interesting and has many new themes, icons and
pictures.

© |t has a new search tool called Cortana. It will help you find
things and get things done easily. The information can be
searched by talking to Cortana.

©  Windows 10 has the Task View button to the right of the Search
button. It will show you all the opened windows on your desktop.

STARTING WINDOWS 10

As we switch on the computer, the
Windows operating system gets
loaded Into the memory
automatically. While loading, the
picture of Windows flag appears
on the screen. After few seconds,
the screen appears.

In the same way, a computer
checks if we have permission to
use the computer or not. The
computer compares the username entered by us, with the names of
the users that have been stored on it.

Each username has a key which is called a password.

After entering the correct username and password, welcome screen
appears. After the welcome message, we will see a screen called
desktop given ahead.
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Icons Desktop

Start Button Taskbar Notification
Area

DESKTOP

The first screen that appears after loading the operating system with
labelled pictures on it is called Desktop.

The desktop is just like your study table, where we keep all useful and
frequently used things like pens, pencils, notebooks, etc. In the same
way, a computer’s desktop contains all the useful and frequently used
programs.

COMPONENTS OF A DESKTOP

Icons

The small labelled pictures on the desktop are
called icons. The icons may represent a file,
folder or a program. lcons are used to open
specific programs. To open any icon, just
double-click on it.

Some of the commonly used icons on the desktop are :
© This PC ©  Recycle Bin
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This PCJH e P i
A computer stores the data in Hard disk, =

CD, DVD, Pen drives or any other - = -
storage devices and this data can be = = &-
accessed from the icon This PC. When =~ == <5

we double-click on this icon, we will get
the This PC window like this:

The different icons can be seen within the computer wmdow In the
figure given, & =" L g and _ 7", icons
show the space on the hard disk d|V|ded into different sections caIIed
partitions. They are usually denoted by letters such as C:, D:, E:, F:,

etc. to store and access data from computer.

Recycle Bin

The Recycle Bin icon is just like a dustbin in our
house. It keeps the file or a folder we deleted till
we empty it.

If we delete any file or a folder by mistake, then
we can restore it from the Recycle Bin.
Double-click on the Recycle Bin icon to open R
it and then right-click on the file or folder we |« wue o e
want to restore. Then, select the Restore

option from the shortcut menu. But, if we | #ue== -

delete the files or folders from the Recycle | oo cu

Bin, these will be deleted permanently from & =« ) —
the computer.

Fa CtKnOW  Local Knowledge
To delete afile or a folder permanently, select it and press the Shift + Delete keys together.
Taskbar

This is the bar at the bottom of the screen. It contains the start button
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on the left corner and clock on the right corner. It also shows the
program that is being used.

n P Type here to search

Start Button |[E}

The Start button appears at the leftmost corner of the taskbar. It is
known as the key to use windows. When we click on the Start button,
the list of options or programs called Start menu appeatrs.

The Start menu of Windows
10 is the combination of
Windows 7 Start menu and
Windows 8 Start screen. On
the left of the Windows 10
Start menu, the middle
section shows the most
used and many recent
added apps and programs.
We can also find File
Explorer, Settings and can
perform common tasks, like starting a program, shutting down the
computer, searching a file or a folder, etc.

To show all the apps installed in a system, select the All apps option.
All the installed apps or programs are shown here in an alphabetical
order.

Whereas, on the right side of the Start menu, we have Windows 10
Tiles. It displays information that are useful at a glance without
opening an app. For example, the Weather tile displays the forecast
while the News tile displays headlines. We can rearrange, resize and
move these tiles to make them work better for you.

o—

I:a ct IGHOW . Local Knowledge

We can also press the Windows key on the keyboard to open Start menu.
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Search Box

The Search box is used to search a program or app
on the computer quickly. For example, to open
WordPad, we can type the word Wordpad in the
Search box.

Task View Button &l

The Task View button is present to the right side of
the search box. It is a quick way to see every
window on our desktop at once, and then we quickly
select the one we want to work with.

Document 1

o—

Fact KhOW . Local Knowledge

To activate the Task View button, press the Windows + Tab keys together.

Notification Area

It is present at the right corner of the taskbar. It has a clock and some
small icons. It tells the status and important notifications about the
programs running on your computer.

At the end of the notification area, there is a Peek button. When you
click on this button, it minimizes all the open windows and shows the
desktop.

Fact KnOW . Local Knowl@

We can also minimize the opened windows by pressing the Windows + D keys together.

To move the taskbar, follow these steps :
Click on the blank area of the taskbar.

Hold down the left mouse button, and then drag the mouse
pointer to the place on the screen where you want to move
the taskbar. For example, you may want the taskbar to be
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positioned vertically on the § :"
right side of your screen.

After you move the mouse &=
pointer to the position on &%
your screen where you want
the taskbar, release the %
mouse button.

The taskbar will be moved to the desired position. If the
taskbar of your computer is not moving, it means it is
locked. To unlock the taskbar, follow these steps :

1. Right-click on the blank area of the taskbar.

2. Select the Lock the taskbar check mark option from
the shortcut menu to hide the check mark.

The taskbar will be unlocked and can be moved.

J&Zco@@act the (G

An operating system is a set of programs which manages all the jobs of a computer and make
it run. It tells a computer how to work.

© The first screen that appears after loading the operating system with labelled pictures on it is
called Desktop. The desktop consists of icons and taskbar.

© The small labelled pictures on the desktop are called icons. The icons may represent a file,
folder or a program. Icons are used to open specific programs.

© Afile is a collection of data. Each file has a different name and is represented by different icon.

© A folder is just like a bag. It is used to store a group of files. We can organize your work by
keeping similar files in one folder.

© The Start button appears at the leftmost corner of the Taskbar. When we click on the Start
button, the list of options or programs called Start menu appears.

(D
NEws

It is a good idea to keep the monitor, CPU and the keyboard covered while the computer is not in use. Good
quality covers protect them against dust and dirt, enabling them to function properly for a long time.
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Tick () the correct answer :

1.

A is a collection of data.

(a) Folder (b) Icon (c) File

The icon keeps the file or a folder we deleted till we empty it.
(a) Recycle Bin (b) This PC (c) None of these

Which of the following is the latest version of Windows operating
system?

(a) Windows 8 (b) Windows 10 (c) Windows 11
The appears at the leftmost corner of the taskbar.
(a) Peek button (b) Notification area? ) (c) Start button

Write ‘T’ for true and ‘F’ for false in the given circles :

1.
2.

3.
4.

To open any icon, just single-click on it.

We cannot move the taskbar to any of the four sides of the
screen.

An operating system tells a computer how to work.

The Start menu of Windows 10 is the combination of Windows 7
Start menu and Windows 8 Start screen.

Fill in the blanks :

1.

2.
3.
4.

An is a set of programs which manages all the jobs
of a computer and make it run.

Windows 10 has a new search tool called
A is used to store a group of files.
At the end of the notification area, there is a

Answer the following questions :

1

2.
3.
4.

What do you mean by an operating system?
Define desktop.

What are icons?

Write any two features of Windows 10.
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Sl’C&HVH:y SI("IS ] Dﬂj Art Integration

2

Draw and colour the logo of Windows 10 on a chart paper.

Visit your computer lab and perform the following tasks :

© Double-click on the This PC icon and see the contents of the hard disk.

© Delete an unwanted file and then restore it from the Recycle Bin.

@  Change the position of the taskbar.

® Lock and unlock the position of the taskbar.

Experience-Based Questions Higher Order Thinking Skills

1. Piya wants to move the taskbar to the top of the screen. But, she is not
able to move it. Suggest her a way to move the taskbar.

2. Arushi is working on many applications. She wants to see every window
on her desktop at once, and then quickly selects the one she wants to
work with. Suggest her a button to complete her task.

Activity Work Cutting & Making Skills

Find out some more features of Windows 10 and prepare a chart on ‘Features
of Windows 10'.

[ —

_DiSCUSSiOI‘\ Communication

Discuss the different features of Windows 10 in class in detail.

Teacher's Help

© The teacher should give enough practice to the students on how to restore files from Recycle Bin and how to
change the position of the taskbar.
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s Working with MS Word 2019
LEARNING

In this chapter, you will learn about :

© Features of MS Word

Creating a New Document

Selecting Text in Word

Changing the Style, Size and Colour of the Text
Closing a Document in Word

Starting MS Word 2019
Entering Text in Word
Deleting Text in Word
Saving a Document in Word

(M)
)]
()]
o Opening an Existing Document in Word

le oo 0 ©

MS Word is one of the most popular products of
Microsoft company. It is a word processing program. |t
is used to write letters, stories, poems, invitations, etc.

FEATURES OF MS WORD

MS Word is a part of Microsoft Office package. Some of the features
are as follows :

(i)  We can type a document and save it.

(i) We can edit the document easily.

(ili) We can use the saved document in future.
(

(

Iv) We can check the spelling and grammar.
v) We can insert pictures and change the way text appears.

STARTING MS WORD 2019

To start MS Word 2019, follow these steps :
Click on the Start button.
Click on the Word.
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When we open Word 2019, the Word Start Screen will appear.
From here, we'll be able to create a new document, choose a
template, or access your recently edited documents.

Step 3. Click on the Blank document to create a new document.

=
=
-
[
¢
L
"
" o

-l .2 Type here to search

Microsoft Word window will appear, named Documentl. The various

parts of Word 2019 window are as follows :

File Tab » b
Quick Access Title Bar Ribbon

Toolbar

AsBbeeDd | AsBbEcDd AaBb(i Ak AdB assccn asscnd assbend 4

i Pw e & ect
Chpbosrd Fa | graph Eddng
1
Groups
g |
S l Scroll Bar «——
£ -
E Rulers
=
Qo
o
& - Work Area > Document
- N i
o Window
< -
¥
H £ Type o

Zoom Slider
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Ribbon

A Ribbon is designed to respond to your current task. It contains
multiple tabs : File, Home, Insert, Draw, Design, Layout, References,
Mailings, Review, View and Help, each with several groups of
commands. You will use these tabs to perform the most common
tasks in Word.

Quick Access Toolbar

It is present at the left-most corner of the Word window. It contains
frequently-used commands. By default, it shows the Save, Undo and
Repeat commands. We can add other commands depending on our
preference.

©  Save button is used to save your document.
@  Undo button is used to undo the previous action.
©  Repeat option is used to repeat the previous action.

Collapse the Ribbon Button

We can collapse the ribbon if we need to see more of the document
we are creating. To collapse the ribbon, click the arrow at the bottom
right. When we click on this button, it will minimize the ribbon, only
the tab names get displayed.

Title Bar

It is present at the top of the Word window. It shows the name of the
document followed by the program name. There are five buttons on
the right side of the title bar. They are Microsoft Word Help, Ribbon
Display Options, Minimize, Restore Down/Maximize and Close.

©  We can search for online help or from the local computer using
the Microsoft Word Help button.

@  We can choose to minimize the Ribbon if we find that it takes up
too much screen space using the Ribbon Display Options button.
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© The Minimize button reduces a window to a small icon on the
taskbar.

©  The Maximize button displays the full-screen view of the window.

© The Restore Down button appears when the window is
maximized. It changes the window to its original size.

©  The Close button is used to close the window.

Work Area

It is the area where we can type text, insert pictures, tables, etc. A
cursor is present in the work area which shows the position at which
text appears when we type.

Dialog Box Launcher

It is the small icon that appears in some groups. If we click on this
icon, a dialog box related to that group opens. It may contain many
options that we can select as per our choice.

Scroll Bars

By default, the Vertical scroll bar and Horizontal scroll bar are shown.
We can hide scroll bars if we want to display more of the document.

©  The Vertical scroll bar is present to the right of the document
window. We can drag the vertical scroll bar up and down to see
parts of a document that are currently not visible.

© The Horizontal scroll bar is present at the bottom of the

document window. We can also drag the horizontal scroll bar left
and right.

Rulers

The Ruler makes easier to adjust our document with precision. If we
want, we can hide the Ruler to create more screen space. There are
two rulers : Horizontal ruler and Vertical ruler.

© The Horizontal ruler is present at the top of the document
window. It is used to set the left and right margins.

= o
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©  The Vertical ruler is present at the left of the document window. It
Is used to set the top and bottom margins.

Status Bar

It appears at the bottom of the Word window. It provides information
such as the current page number, number of pages and words in the
document on its left side. The View button and the Zoom slider are
present on its right side.

© The View buttons are a feature that lets us change how the
document appears. We can choose to view our document in Read
Mode, Print Layout, or Web Layout. These views can be useful
for various tasks, especially if we're planning to print the
document.

© The Zoom slider is available for zooming in and out of documents
quickly and easily.

*—

Fact KhOW . Local Knowledge

On clicking the File tab, the Backstage view appears. The Backstage view gives us
various options for saving, opening a file, printing and sharing your document.

CREATING A NEW DOCUMENT

To create a new document, follow these
steps :
Click on the File tab. The '

Backstage view wil appear. Ml = T =
Select New option. i = = =

Click on the Blank document. e ———

A  new blank document
window will appear on the
screen.

- - - - ]
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I:a ct IGIIOW . Local Knowledge

We can press the Ctrl+N keys to create a new document.

ENTERING TEXT IN WORD

The insertion point or cursor is the blinking vertical line in our
document. It indicates where we can enter text on the page. When a
new blank document opens, the insertion pomt IS Iocated in the top—
left corner of the page. Do ™ ' s
not press the Enter key -
when you reach at the end
of the line. As you type
the text, the insertion
point automatically shifts
to the next line as needed.
This feature is called Word
Wrap. Press the Enter key @~ =
only to start a new line.

We can insert text to an existing document. Use the mouse to move
the insertion point to a specific place in our document. Simply click
the location in the text where we want to insert text. Now start typing
the text. The existing text which is placed after the cursor will be
shifted to the right side and new text will be inserted.

SELECTING TEXT IN WORD
To select text in Word, follow these steps :
Place the cursor before the text you want to select.

Now, keeping the mouse button pressed, drag the mouse
over the text to be selected. Then, release the mouse.

You have selected the text. A highlighted box will appear
over the selected text.
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Video provides s powerful way to help you prowe your point. When you click Ondine Video, you can
paste in the embed code for the video you want to add, You can also type a keyword to search online
for the video that best fits your document.

To make your document look professionally produced, Word provides header, footer, cover page, and
teut box designs that complement each other. For example, you can add & matching cover page,
header, and sidebar. Click insert and then choose the elements you want from the different galleries.

DELETING TEXT IN WORD

To delete the text in Word, follow these steps :
Step 1. Select the text you want to delete.
Step 2. Press the Delete or Backspace key.
The selected text will be deleted.

CHANGING THE STYLE, SIZE AND COLOUR OF THE TEXT
We can change the style, size and colour of the text.

Changing the Font of the Text
To change the font of the text, follow these steps :
Step 1. Select the text.

Step 2. Click on the down arrow next to the Font box in the Font
group on the Home tab.

irsert  Draw  Desgn  Layout  Referenoes Madlings  Reviow View  Help ¢ Tell me what you waei 1o do
- . 4 T i S
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-
P W | nemeFoms = e g b, Replace
W Fommiat Ralmer, | (e T T S T R T i | e e Sele
“alibei Ligl
Cliphosrd libri Paragraph Styles Editing
Calibri y 18
llllllll
Agenoy Fi
ALGERIAN
Arial
Arial Black
HAuial Narmow Tomake your document look professionally produced, Word provides haader, footar, cover page, and
Arial Rounded MT Bold text box designs that complement each other. For example, you can add a matching cover page,
Bahnschrift header, and sidebar. Click insert and then choose the elements you want from the different galleries.
Bahnschrift Condensed Themes and styles also help keep your document coardinated. When you click Design and choose a
Bahnschrift Light new Theme, the pictures, charts, and SmartArt graphics change to match your new theme. When you
Bahmschrift Light Condanzed apply styles, your headings change to match the new theme.
Bahnschrift Light SemiCondensed Save tima in Word with new buttons that show up where you need them. To change the way a picture
Bahnschrift SemiBold fits. in yos cument, click it and a button for layout options appears next to it. When you work on a
Bahnschrift SemiBold Condensed = tobleli ere you want to add a row or & column, and then click the phes sign.
Bahnschrift SemiBold SemiConden Reading is easier, toa, in the new Reading view. You can eollapse parts of the document and focus on
Bahnschrift SemiCondensed the text you want. f you need to stop reading before you reach the end, Word remembers where you
Bahnschrift SemiLight left off - even on another device.
Bahnsehrift Semilight Condensed
Bahnschrift SemiLight SemiConde
Buskerville Old Face
Ravhaus 93
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Step 3. Select the desired font.
Notice that the font of the selected text changes.

Always choose a font which is clear and easy to read. It is not easy to
read, if you mix different types of fonts in the same sentence.

Changing the Size of the Text
To change the font size of the text, follow these steps :
Step 1. Select the text.

Step 2. Click on the down arrow next to the Font Size box in the Font
group on the Home tab.

woitiody I KA A W MY | amscend) mescend AaBbCE Asshcer AQB ssssceo assbcod dembeend
u g . o . . ' 1 e S ® Hewding . " WL £
¥ Foremat Painter :

ot . .

for the video that best fits your document.

To mak i
el box ﬂei‘sﬂs that complement each other. For example, you can add a matching cover page,
header, and sidebar. Click Insert and then choose the elements you want from the different galleries

Step 3. Select the desired font size.
The size of the selected text will be changed.

Changing the Colour of the Text
To change the colour of the text, follow these steps :
Step 1. Select the text.

Step 2. Click on the down arrow T —
next to the Font Color “= - _

option in the Font group :_-’.!?!Et.::m.mmwm
on the Home tab. sl vomorlimions
' I s crfen fr th i 0 bt
Step 3. Select the desired font

colour.

The colour of the selected &«
text will be changed.
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SAVING A DOCUMENT IN WORD
To save a document, follow these steps :

Step 1. Click on the File tab. The Backstage view will appear.
Step 2. Select the Save option.
Step 3. Select the This PC option. - -
Step 4. Click on Browse button. =
Step 5. Select the location where )
you want to save your file.
Step 6. Type the file name.
Step /. Click on the Save button.
FactKnO‘W' ) Local Knowledge

We can press the Ctrl+S keys to save the file in Word 2019.

The Save As command is used to create a copy of a document while keeping the
original. When we use Save As, we will need to choose a different name and/or
location for the copied version.

CLOSING A DOCUMENT IN WORD
To close a document, follow these steps :

Step 1.
Step 2.

Step 3.

Click on the File tab. The Backstage view will appear.

Select the Close option. Word will ask to save the
changes, if there are changes in the document
that have not been saved.

Click on the Save, if you want to save the changes.

Microsoft Word *

.I Want to save your changes to Document3?

If you click "Dan't Save", a recent copy of this file will be tempararily available.
Learn more

Daon't Save Cancel
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Fact KhOW . Local Knowledge

*—

We can press the Ctrl + W keys together to close a document in Word.

OPENING AN EXISTING DOCUMENT IN WORD
To open an existing document, follow these steps :

Fact KhOW . Local Knowledge

Click on the File tab. The Backstage view will appear.
Select the Open option.
Select the This PC option.
Click on Browse button.
Select the file.

Click on the Open button.

o—

We can press the Ctrl + 0 keys together to open an existing document in Word.

@@co@@ect the

©  Microsoft Word is the most popular word processing software.
©  Microsoft Word (MS Word) is a part of Microsoft Office package. It is a word processing

©

application that allows you to create a variety of documents like letters, flyers and reports.

The Quick Access Toolbar is present at the left-most corner of the Word window. It contains
frequently-used commands. By default, it shows the Save, Undo and Repeat commands.

A Ribbon is designed to respond to our current task. It contains multiple tabs File, Home,
Insert, Design, Page Layout, References, Mailings, Review and View.

Status bar appears at the bottom of the Word window. It provides information such as the
current page number, number of pages and words in the document on its left side. The View
button and the Zoom slider are present on its right side.

Do not pull the wires of the keyboard and mouse.

=8 1,
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Tick () the correct answer :

1.

The scroll bar is present to the right of the document
window.

(a) Vertical (b) Horizontal (c) None of these
Which of the following is displayed just below the title bar?

(a) Work area (b) Status bar (c) Ribbon

The Backstage view appears on clicking the tab.

(a) Home (b) File (c) Design

We can press the keys together to close a document
in Word.

(a) Ctrl+S (b) Ctrl+W (c) Ctrl+0

Write ‘T’ for true and ‘F’ for false in the given circles :

L.
2.

3.
4.

We cannot change the colour of the text in Word 2019.

The Save As command is used to create a copy of a document
while keeping the original.

To create a new document, press the Ctrl + N keys together.
The Ruler makes easier to adjust our document with precision.

Fill in the blanks :

1.

The is available on the status bar for zooming in and
out of documents quickly and easily.

The Font Size box is present in the Font group on the
tab.

There are buttons in the right side of title bar.

The button reduces a window to a small icon on the
taskbar.

Answer the following questions :

1.
2.

What is the use of title bar?
How many scroll bars are there in Word 20197 Name them.
=8 o
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3. Write any two features of Word 2019.
4. What are the various parts of the Word 2019 window?

SfC&HVHZH Ski"S i ﬂ Art Integrm

4 )

Draw and colour the logo of Word 2019 in the space
given alongside :

Open Word 2019 and write five sentences about the following :
1. My Family 2. My Favourite Game

Experience-based Questions Higher Order Thinking Skills

1. Rahul wants to change the font size and colour of the text. Suggest him
the options to complete the task.

2. Anaya wants to save the document using the keys of the keyboard. Can
you help her in completing the task?

Think & Answer Life Skills & Values |

What will you do if your friend leaves the computer lab without saving his/her
document? Save the document or Close the document without saving? Justify your
answer.

Activity Work Cutting & Making Skills
Prepare a chart on ‘Parts of the Word 2019 window’.

[ —

_DiSCUSSiOI‘\ Communication
Discuss the different features of MS Word in class in detail.

Teacher's Help
©  Give the students enough practice on using various options present under the File tab.
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" y Paint 3D
- G
LEARNING

In this chapter, you will learn about :

© What is Paint 3D? O Starting Paint 3D

©  Components of Paint 3D Window ©  Using 3D Library

©  Working with 3D Shapes O  Brushes

O Erasing a Drawing ©  Saving a Drawing
©  Opening a Project

WHAT IS PAINT 3D?

Paint 3D is a wonderful tool designed by Microsoft for drawing
different types of 2D and 3D objects.

A simple Paint program was included with all earlier versions of
Windows, still widely used for creating 3D shapes. In the latest
update to Windows 10, Microsoft included Paint 3D having vast
library of 3D objects and tools to draw pictures.

STARTING PAINT 3D

To open Paint 3D, follow these steps :
Simply type Paint 3D in J&%
the search box. =
Now, click on the Paint 3D e
application from the list. @

The paint 3D window will
appear. -

Click on the New option to
create a new project.
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COMPONENTS OF PAINT 3D WINDOW
The components of Paint 3D window are as follows :

1. Title Bar . It displays the name of the current project.

2. Menu Button : It contains many options to work.

3. 2D Shapes : Itis used to draw 2D shapes.

4. 3D Shapes : ltis used to draw 3D shapes.

5. Stickers . It is used to add different stickers.

6. Brushes . It displays different types of brushes in the

Brushes panel.

/. Text . It is used to add text.

8. 3D Library : Itis used to add 3D objects.

9. Canvas . It is the area where we draw in Paint 3D.
MENU  Title Bar gyppes Stickers iy

»3D Library

Cahvas

n 5 e b b acainch
USING 3D LIBRARY
We can insert any ready-made 3D objects in our drawing from the 3D

library. I

For this, follow these steps : ‘\*, ~ i

Step 1. Click on the 3D library option. '“' % ,,

Step 2. Select a Category by clicking e S
on it. % 9

| o [CR—
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Select a 3D object and click on it to insert.
© Rotate the image using the rotation handle, if required.

o  Slide it forward or backward using the Z-axis position
button, if required.

WORKING WITH 3D SHAPES
To draw a 3D shape, follow these steps :
Click on the 3D shapes %88 button.
Now, choose the tool sphere from the 3D shapes panel.

Then, move the mouse pointer to the canvas area. The pointer
changes into a ‘+’ sign. Hold the left mouse button and drag
the mouse to draw the sphere. Release the mouse button.

Select the Edit Color option from the 3D selection panel to
colour the sphere.

After completing, click anywhere outside the image.

' Local

= . Fact®IKnow  Knowledge

‘ While using the sphere tool, press the
. il Shift key to draw a perfect sphere.

TO DRAW A 3D CYLINDER

To draw a 3D cylinder, follow these steps :
Click on the 3D shapes option.
Select the Cylinder object from the 3D shapes panel.

Move the mouse pointer to the canvas area. Hold down the left
mouse button and drag the mouse to draw the 3D cylinder.

Release the mouse button and click outside the object, once
done.

- o
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Step 4. Add colour of your choice to the 3D cylinder by using the
Edit Color option.

BRUSHES

In Paint 3D, Brushes are used to colour and draw free-hand objects.
There are various types of brushes in Paint 3D like Marker, Calligraphy
pen, Oil brush, Watercolor, Pixel pen, Pencil, Crayon and Spray can.

To use a brush, follow these steps :

Step 1. Click on the Brushes option.

Step 2. Select the Oil Brush g from the Brushes panel.
Step 3. Drag the Thickness slider to increase the size of the brush.

Step 4. Now, move the EiS
pointer to the
Canvas area. Press l
and hold down the

.
left button of the . _"_,
\

mouse and drag
the mouse to draw
different lines.

ERASING A DRAWING

The Eraser tool is used to erase any part of a drawing or a complete
drawing.

To erase a drawing, follow |l
these steps : —

Step 1. Choose the Eraser = =
tool R from the o, -
Brushes panel. e
Step 2. Drag the Thickness T S,
slider to change the
size of the eraser. . P
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Hold down the left mouse button and move it to the area you
want to erase.
FaCtKnOW ~ Local Knowledge

If you want to clear all the objects from the drawing area, select all the objects and

click on the Delete key.
SAVING A DRAWING

It is important to save our drawing after finishing the work. Once it is

saved, we can reuse it any time.
To save a drawing, follow these steps :

Click on the Menu =~
option and then select :- || -
the Save option. ;:
Select the Paint 3D -
project option. A dialog

box appears. .
Enter the file name and
then click on the Save

in Paint 3D button.

”~

e If you want to save your drawing as an Image or 3D model, click

on Menu — Save — Image/3D model.

Local
o The Save As dialog box appears. FactTd IGhOW Knowledge

*—

o Enter the file name and click on  F12 key can be used to save a Paint

Save. 3D drawing for the first time.

OPENING A PROJECT
To open an existing drawing, follow these steps :
Click on the Menu option and select the Open option

The Open panel displays a list of projects saved in Paint 3D.

Select the desired project.
=8 o
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Pamt 3D is a wonderful tool designed by Microsoft for drawing different types of 2D and 3D
objects.

©  Brushes option displays different types of brushes in the Brushes panel.

]

3D library is used to add 3D objects.

© There are various types of brushes like Marker, Calligraphy pen, Oil brush, Watercolor, Pixel
pen, Pencil, Crayon and Spray can.

1Y Frercice

)

Tick () the correct answer :
1.

Which option is used to add 3D objects?

(a) Text (b) 3D Library (c) Canvas
Which tool is used to draw a cylinder?
(a) Sphere (b) Cylinder (c) Oval

is the area where we draw in Paint 3D.
(a) Text (b) Title Bar (c) Canvas

B. Write ‘T’ for true and ‘F’ for false in the given circles :

L.
2.
3.
4,

We can draw both 2D and 3D shapes in Paint 3D.
There are two types of brushes in Paint 3D.

Paint 3D includes in the latest update of Windows 7.
We can save a project for the first time using F12 key.

C. Fill in the blanks :

1.

2.
3.
4

contains many options to work.

is used to add different stickers.
displays the name of the current project.
is used to add text.
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D. Answer the following questions :
1. What is the use of Eraser tool?
2. What is the use of Paint 3D program?
3.  What is the use of Sphere and Cylinder tools?
4. What are brushes? Name any three brushes.

Draw a Hemisphere.

Experience-based Questions Higher Order Thinking Skills

1. Nisha wants to draw a hemisphere. Help her in completing the task.

2. Aman wants to use different types of Brushes in Paint 3D. Help him in
completing the task.

Think & Answer Life Skills & Values |

Your teacher has thought you a new application but you are unable to
understand, then what will you do? Will you pretend that you have understood
or ask your friend or teacher to make you understand it? Justify your answer.

Activity Work Cutting & Making Skils |

Find out some differences between MS Paint and Paint 3D and write them on a
chart paper.

[ S

_DiSCUSSiOH Communication

Discuss the different components of Paint 3D window in class in detail.

Teacher's Help
©  Explain the different brushes to students in class in detail.

= 1,
@ 48 Computer-3 o
&)



M
9

&) -

S Let's Code with KTurtle

LEARNING [0]8) (e{e] | 3]
In this chapter, you will learn about :
© How to Start KTurtle?

© Saving a Program

©  Open an Existing File

o Setting Canvas Size and Colour

KTurtle Commands

Creating a New File

Saving an Image

Setting Pen Colour and Pen Width

O © © ©

KTurtle is a computer language useful for learning programming. It is
very simple, interesting and easy to learn. It is used to draw figures
and perform simple calculations. It uses a turtle for drawing.

The Turtle, originally a robotic creature that sat on the floor and could be
directed to move around by typing commands at the computer. Soon the
turtle migrated to the computer graphics screen where it is used to draw
shapes, designs and pictures. The turtle is also known as Sprite.

HOW TO START KTURTLE?

To start KTurtle, follow these [
steps :

® DO Installer

Click on the Start
button.

Click on All apps.

KDE Shutdown

Kig (Interactive Geometry)

Kiten (Japanese Reference-Stud...
- KMetAttach (Metwork Folder Wi...
* KTouch (Touch Typing Tutor)

4 Klurtle (Educational Programmi...

e Back
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Step 3. Click on KDE Release folder.

Step 4. Select KTurtle (Educational Programming Environment).

We can also double-click ' on the icon on the desktop to start KTurtle.
The KTurtle window appeatrs.

Title Bar Mehu Bar Console Text Box
T A A
& untitled - KTurtle [ - u] 0
File Edit Canvas Run Toocls Settings Heip
Toolbar 4 D e E_:H()pen HSwe HS&\'E.&S @R,un » (A1) Pause it |Consoles | | 9&!&111
|Editor X Inspectar X
1] variables | Functions | Tree |
Editor <
Pane
Inspector
Pahe
L English [built in] | Line: 1 Column: 1 | INS | untitled
v v
Cahvas Status Bar Turtle

The KTurtle window is divided into three main parts :
o  Editor Pane @ Canvas © Inspector Pane

Editor Pane

The Editor pane is present on the left where you type the commands
or instructions.

Canvas

The Canvas is the space in the middle of the screen where the turtle
moves to make your drawing.
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Inspector Pane

The Inspector pane is present on the right side of the screen. It gives
us information when our program executes.

The Editor and the Inspector panes can be attached to any sides of
the KTurtle window. This can be done by placing the mouse on the
title bar of the pane, pressing the left mouse button and then dragging
it to one of the sides of the KTurtle window.

Besides these, we find the following on the screen :

Toolbar

This bar has buttons that allows us to quickly select the most used
actions. It also has a Console text box that allows us to enter a one
line command to test by pressing the Enter key or clicking the Execute
button to run it.

Menu Bar

It is the bar from where all the actions can be reached. It consists of
File, Edit, Canvas, Run, Tools, Settings and Help.

Status Bar

It is present at the bottom of the window where we will find feedback
on the state of KTurtle. It shows the last action performed on the left
side and the current location of the cursor (Line and Column number)
and the current language being used for the commands on the right
side of the screen.

KTURTLE COMMANDS

To type the commands in KTurtle, click inside the Editor pane after
number 1 and type the first command. Now, press the Enter key. The
cursor will move to the next line. Similarly, we can type the rest of the
commands.

Always remember to press the Enter key after each command.

- o
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Then, click on the[®=+ button on the toolbar.
@Run w (i1) Paise

This will start the execution of the commands We - ... . rsionting snc mspecten
have typed in the Editor pane.  Eull Speed

On clicking the arrow button next to the
command, a drop-down menu appears. BRI

By default, the execution speed of the program is set to Full Speed. But,
we can change the execution speed of the program by clicking one of
the options from the menu of command. We can select any
option. The check mark will appear to the left of the selected option.

We can also press the F5 key or click on the Run menu and select the
Run option to run a program.

Let us learn some KTurtle commands to make the turtle move.

Slower

Slowest

forward Command

The forward command is used to move the turtle in the forward
direction. The short form of forward is fw. The steps for using the
forward command are :

Type the forward or fw command.

Press the Spacebar key.

Type the number of steps.
Don’t forget to give a single space between the command and the
number. For example, if you type fwlOO, an error message “An

unknown function named 'fwl00’ was called” will appear. Then
click on the Hide Errors button and correct the error.

Write the command to move the turtle in forward direction by 100 steps.

Command (s) to be typed in editor pane | ~ Output |

forward 100

or ZTi
fw 100
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backward Command

The backward command is used to move the turtle in the backward
direction. The short form of backward is bw.

The steps for using the backward command are :
Type the backward or bw command.
Press the Spacebar key.
Type the number of steps.

We can also move the turtle in forward direction using the backward
command by giving the negative input to the bw command. For
example, bw =50 will move the turtle in forward direction by 50
steps.

Similarly, we can move the turtle in backward using the forward
command by giving the negative input to the fw command. For
example, fw =50 will move the turtle in backward direction by 50 steps.

Write the command to move the turtle in backward direction by 100
steps.

Command (s) to be typed in editor pane | ~ Output |

backward 100
or _
=l

bw 100

turnright Command

The turnright command is used to turn the turtle towards its right, i.e.
in the clockwise direction. While turning, the turtle rotates, but stays
at the same position. The short form of turnright is tr.

The steps for using the turnright command are :
Type the turnright or tr command. We can move
Press the Spacebar key. the turtle from
Type the number of units or degrees. 0 to 360 degrees.

- o
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Example : 1. Type the commands shown in the figure in Editor Pane.
2. Click on the Run button.
The following shape will be drawn on the Canvas.

i KTurtle = O 4
File Edit Canvas Run Tools Settings Help

lﬁlr‘dew Ib“lopen HSave MSEVEAS @Run » L) Pause Abort  |Console: j [} Execute

Editor Fx Inspector

7 X
i fw 50 Varizbles l Functions l »
Z tr 80

3 £w 100 name |-ell.ie |+.; pe ‘
4 tr 90
5 fw 50 Mo variables
6 tr 90

fw 100
; te 20
3l

T

turnleft Command

The turnleft command is used to turn the turtle towards its left, i.e. in
the anti-clockwise direction. While turning, the turtle rotates, but stays
at the same position. The short form of turnleft is tl.

The steps for using the turnleft command are :
Type the turnleft or tl command.
Press the Spacebar key.
Type the number of units or degrees.
Example :1.  Type the commands shown in the figure in Editor Pane.
2. Click on the Run button.
The following shape will be drawn on the Canvas.

5 KTurtle — O *
Eile Edit Canvas Run Tools Settings Help

(=0 = Pen ave dVE AS > i1 ) Fause Abort oNs0oie; x XeCu
Onen L0 5 Save A R P Consal Execute

Editor g x Inspector g X
1 tl 90 Variables ] Functions ] 4
2 Bw 30
3 tl 80 Narme | alue ‘t_ pe ‘

4 fw &0
5 tl 90 Mo variabl
& fTw 60
£k 80
g fw 60
% tY 80
10 fw 30
IL t1 80

12 fw &0
13
ebs
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direction Command

The direction command turns the turtle in clockwise direction without
using the tr or tl commands. The short form of direction is dir.

Fact KnOW . Local Knowledge

In tr and tl commands, degrees are counted from the current position whereas in the
direction command, degrees are counted from the starting position of the turtle each
time the command is given.

The steps for using the direction command are :
Type the direction or dir command.
Press the Spacebar key.
Type the number of units or degrees.

Click on the Tools menu and select Direction |Iools Settings Help
Chooser... option, if you are not sure of how many
degrees the turtle should move. The Direction Chooser ===
—KTurtle dialog box appears.

©  Select the command type: turnleft, turnright or any direction.

©  Previous direction shows the previous | # o ? X
direction of the turtle.

© New direction shows the new direction
of the turtle. \ / —
o A text box shows the command. ‘ - —

180

©  Click on the Paste to editor to paste the | mmw
command in the Editor Pane. =

©  Click on the Close button.

f Copytncﬁpbmrd| [ Pas!ttoedimr|

center Command

This command brings the turtle to the center of the canvas without
drawing a line. The head of the turtle points in the same direction as
in the previous command.

=8 1,
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reset Command

The reset command cleans up the canvas completely. We can use it
whenever we want to try a new set of commands.

spritehide Command

The spritehide command is used to hide the turtle from the canvas. The
turtle can draw lines even when it is hidden. The short form of spritehide is
sh. Type the spritehide or sh and press the Enter key to use this command.

clear Command

The clear command will clean all drawings on the canvas. But the
position and angle of the turtle will remain as they were. The short
form of clear command is ccl.

spriteshow Command

The spriteshow command orders the hidden turtle to get back on the
canvas. The short form of spriteshow is ss. Type the spriteshow or ss
and press the Enter key to use this command.

SAVING A PROGRAM You can also click on

the Save As
I :
To save a program, follow these steps button =

Click on the File menu.

Clok on the Save As e IDIESE IR E OO D

option. The Save AS |tomwe o - | ie

dialog box appeats. & S S

Type the file name. ET—

Click on the Save button. |cem  aw | o

Eguit ca | e _

Fa CtKnOW _ Local Knowledge

turtle is the extension of KTurtle file.

Always click on the Save As command if you want to save a file with
a new name, whereas click on the Save button to continue saving

- o
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the file with the same name. When we save the file for the first
time, both the commands will open the Save As dialog box.

CREATING A NEW FILE

To create a new file, follow these steps :
Step 1. Click on the File menu.

Step 2. Click on the New option.

OPEN AN EXISTING FILE

ﬁ Prograrml.turtle — KTurtle

File Edit Canvas BRun Jools Set

b Dlew Ctrl+N F

Q Open... Ctrl+O
© Open Recent »

To open an already existing file, follow these steps :

Step 1. Click on the File menu.

Step 2. Click on the Open option. The Open
dialog box appears.

Step 3. Select the file.
Step 4. Click on the Open button.
The selected file will be opened.

SAVING AN IMAGE
To save an image, follow these steps :
Step 1. Click on the Canvas menu.

Step 2. Click on the Export to Image (PNG)...
option. The Save as Picture dialog
box appears.

Step 3. Type the name for the picture.
Step 4. Click on the Save button.

SETTING CANVAS SIZE AND COLOUR

ﬂ Program.turtle — KTurtle
File Edit Canvas Run Tools Sef

¥ New Ctri+N | |
= COpen... Ctrl+0

ﬁ KTurtle

File Edit | Canvaz Run Toels Settings H
© new Export to Image (PNG]... d
Export to Drawing (SVGl.. |

Editor

on = Print Canvas...

[ERE B = VI AR S T S B
Fh oot Fhoot Fhoot
L hEhRh <RI
L3 W o LA
== oo B e R e S o ]
pt

To change the canvas size and colour, canvassize and canvascolor

commands are used.

canvassize Command

The canvassize command is used to set the width and height of the
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canvas. For example, canvassize 100,200 sets the canvas width to
100 steps and height to 200 steps.

canvascolor Command

The canvascolor command is used to change the colour of the canvas.
For example, canvascolor O, O, O makes the canvas black. O, O, O is
called the RGB value. The first number stands for Red, second
number for Green and third number for Blue. Each of them can take
values from O to 25b.

To0: semnae men | YWe can also change the colour values by clicking on

pirection chosser.. | the Color Picker... option of the [# cursaeimee rx

Tools menu. The Color Picker | s ] i

dialog box appears. p—— T CE

©  Move the slider of the red, green and blue _
colours.

. [¢, 138, 22¢ @ Copymdiphoafd] i Pastemedtnr|

The corresponding colour appears. ]

The text box shows the RGB numbers.
Click on the Paste to editor button.
Click on the Close button.

The Clear command does not affect the canvas colour and canvas
size. They will remain same. While if you use the reset command

after setting the canvas size, then the canvas colour will be set to
white as before.

SETTING PEN COLOUR AND PEN WIDTH

To change the pen colour and pen width, pencolor and penwidth
commands are used.

© 0 o0 0

pencolor Command

The pencolor command is used to set the colour of the pen by
changing the RGB values. The short form of pencolor is pc.
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For example, pc 255, 255, 0 changes the colour of the pen to yellow.

penwidth Command
The penwidth command is used to set the width (size) of the pen. The

short form of penwidth is pw. —%
For example, pw 30 sets the pen ““ e — -
width to 30 units. ===
1. Type these commands in Editor LF

pane. i

2. Click on the Run button. o
The output shown alongside will ::
appear on the Canvas.

Jeacowact the (G

KTurtIe Is a computer language useful for learning programming. It is used to draw figures and
perform simple calculations. It uses a turtle for drawing.

®© The forward command is used to move the turtle in the forward direction. The short form of
forward is fw.

© The backward command is used to move the turtle in the backward direction. The short form of
backward is bw.

®© The direction command turns the turtle in clockwise direction without using the tr or tl
commands. The short form of direction is dir.

© The reset command cleans up the canvas completely. We can use it whenever we want to try a
new set of commands.

© The canvassize command is used to set the width and height of the canvas.

®© The canvascolor command is used to change the colour of the canvas.

Always cover your computer when not in use.
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Tick (v) the correct answer :
1. Which of the following commands do not take input?

(a) clear (b) fw (c) dir
2. Which of the following panes is used to type commands?
(a) Inspector (b) Editor (c) Canvas

3.  Which of the following commands moves the turtle by 70 steps in
backward direction?

(a) bw -70 (b) fw -70 (c) fw 70
4.  Which of the following commands is used to turn the turtle left by
/5 degrees?

(a) tl 75 (b) tr 75 (c) dir 75

Write ‘T’ for true and ‘F’ for false in the given circles :

1. We can change the execution speed of the program.

2. The pc command is used to set the colour of the canvas.
3. .kturtle is the extension of the KTurtle file.

4.  We can also press the F/ key to run a program.

Fill in the blanks :

1. The command is used to move the turtle in the
backward direction.

2. The command is used to turn the turtle towards its left.

3. The command is used to hide the turtle from the
canvas.

4. The command is used to set the width of the pen.

Answer the following questions :

1. What is the difference between reset and clean commands?

2. What is the difference between spritehide and spriteshow commands?
3. Name the three main parts of the KTurtle window.

4. Name the commands use to change the colour and size of the pen.
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=(r ea'!:iVﬂ:H Sl(i"S ] ﬂ Art Integration

2

Draw and colour the Turtle of KTurtle on a chart paper.

Project Time Practical Skills

Draw the following figures in KTurtle :

*-—

Experience-Based Questions Higher Order Thinking Skills

1. Nidhi’s teacher asked her to turn the turtle in clockwise direction without
using tl or tr commands. Can you help her in completing the task?

2. Ankur wants to move the turtle backward by 100 steps. He has given the
command backward 100. Can you perform the same task using the
forward command?

Think & Answer Life Skills & Values |

Your friend forgets to give space between the bw command and the input.
He/she is trying again and again but unable to solve the problem. But, you
know the process. What will you do? Do you help him/her? If yes, then how?

Activity Work Cutting & Making Skills

Prepare a chart on ‘Parts of the KTurtle window’.

> —

_DiSCUSSiOI’\ Communication

Discuss the different commands which turn the turtle in clockwise or anti-
clockwise directions.

Teacher's Help
©  Explain the concept of primary colours red, green and blue to students before teaching the canvascolor and
pencolor commands.

\ M 1,
@ 53 Computer-3 o
&)



Let's Decode

Find the correct letter for the given code and decode the computer terms
given below :

A B C D E F G H I J
1 2 3 4 5 6 7 8 9 10
K L M N 0 P Q R S T
11 12 13 14 15 16 17 18 19 20
U ) w X Y Z
21 22 23 24 25 26
1916 5 1 11 5 18 19 16 18 9 14 20 5 18
21 16 19 3 16 21
13 15 14 9 20 15 18 13 9 3 18 1516 8 15 14 5
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_ a Knowing About Scratch
LEARNING

In this chapter, you will learn about :

© Whatis Scratch? ©  How to Start Scratch?

©  Working with Sprite ©  Javing a Project

© C(Creating a New Project ©  Opening an Existing Project
© kExiting Scratch

A computer would have no idea about what we are saying because a
computer cannot think by itself and we cannot talk to it like a person.

We have to give them instructions in special computer languages that
computers can understand. It understands only a few special
languages of its own, called programming languages. Also, the
number of words and the sentences that it understands are limited.

A programming language has a set Local

of instructions called program, for Fact ¥ K(hOW Knowledge

instructing a computer t0 perform seratch was designed by the MIT
specific tasks. In this chapter, we (Massachusetts Institute of Technology)
will learn about one of the easiest Media Lab's Lifelong Kindergarten

computer languages- Scratch. Group, led by Mitchel Resnick in 2003.

WHAT IS SCRATCH?

Scratch is a programming language and an online community where
children can program and share interactive media such as stories,
games and animation with people from all over the world. As children
create with Scratch, they learn to think creatively, work collaborately
and reason systematically.
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HOW TO START SCRATCH? )

Local

To start scratch, follow these steps :  Fact¥Z¥ JGhOW  _Knowledge
Click on the Start button. Scratch is available in 40 languages
Click on the Scratch 2 option. and used in more than 150 countries.

The Scratch window appears. The various components of Scratch
window are as follows :
Title Bar Menu Bar  Sprite Toolbar

% Scratch 2 Offfine Editor e ] x

Screeh :
t - » Block Menu

Green Flag <
1

View FU" ) - [l Seripts I > TabS

meree I steps

Stop Button <

e ¢ B et

-..
Stage «— ‘

» Scripts Area

]
g
%
Q
=
=]

Sprite <

= glide ) secs 1o = @ v O

X 240 i
| Hew sprite =4 / H’ |

> Blocks Palette

j=tr v

Sprite List New Sprite
Buttons

Let us understand some important components of Scratch window.

Sprite

Scratch projects are made up of objects. The most basic object in
Scratch is the Sprite. It is a small graphic character that performs
actions in Scratch projects. There are many in-built Sprites in Scratch.
Cat is the default Sprite in Scratch.

Stage
It is the main working area where all of the actions take place by the
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Sprite as per the given instructions. It displays your creation. We can
see your stories, games and animations created by us.

Blocks Menu

The Blocks menu area lists the ten categories of blocks Motion, Looks,
Sound, Pen, Data, Events, Control, Sensing, Operators and More
Blocks. Related instructions are grouped together in a Block. For
example, all the movement related instructions are listed when we
select the Motion Block. The block categories are all colour coded. So
when we see a block of a specific colour, we can quickly determine
which category it came from.

Tab
It consists of three tabs : Scripts, Costumes and Sounds.

©  Scripts tab : Script is a set of stepwise instructions given to the
Sprite to do a specific task. Script is also called a program. Each
instruction is also called a command. It consists of the block
menu and allows us to write a script.

@  Costumes : It allows us to draw, import or edit images for a Sprite.

©  Sounds : It allows us to record or import sound files for a Sprite
to use.

Blocks Palette

We can find the various types of instructions in the Blocks Palette
used to program the sprite and give instructions to it. It is used to
create a script in Scratch.

Green Flag

It is a small green icon placed at the top-right corner of the stage
screen. On clicking this button, the script will run step-by-step.

Scripts Area | m
Scripts area is the place where we write the script for the Sprite. Drag the
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instructions from the blocks palette and drop it in the Scripts area to
write a program. The blocks fit into each other as jig-saw puzzle blocks.

Stop Button (@

It is also placed at the top-right corner of the stage screen. It is red in
colour and is used to stop the project at any time during the execution.

WORKING WITH SPRITE

Moving a Sprite
To move or turn the Sprite around through different angles, use the
blocks in the Motion block category.
Let us create our first Scratch project to move the Sprite.
Click on the Motion block category in the Blocks menu.
Click on the BZX=E=3 and drag it in the Scripts area.
Now, click on the and drag it in the Scripts area.
Click any of the block in the Scripts area.

We notice that the Sprite moves the specified number of steps and
then turns itself.

% Scratch 2 Offline Editor e o X

[.] 1~ . Scripts

!
.
:

mave @ stops
hmn{"deq-g\s

D
R
1 86
¥ I
?B
i|i

{l
9

Motion Blocks Used in the Project

This block is used to move the Sprite by 10 steps in
forward direction.

move steps

This block is used to turn the Sprite in clockwise
direction.
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ﬂmest-:ps

We can change the number of steps the Sprite
moves, by clicking inside the number of area and
typing the new number. Similarly, we can change the
turning value. move €T steps

To move the Sprite in backward direction, type the number with a
minus (=) sign, say —10.

To remove the block from the scripts area, right-click on it and select
Delete option.

Drawing a Square

To draw lines on the stage, the Pen block category is used. Let us
draw a square on the stage.

Click on the Pen block category in the Blocks menu.

Click and drag the , and on the
Scripts area.

Click on the Motion block category in the Blocks menu.
Click and drag the and on the Scripts

area. .
Click any of the block . .= —
in the Scripts area till E
the Sprite completes s
square.
)
=
— 0.0
,% B We can also make this square
T colourful.
Pl -8
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Pen Blocks Used in the Project

This block is used to draw line as the sprite moves
on the stage.

: This block is used to set the thickness of the pen to
a specific number.

This block is used to set the colour of the pen.

change pen color by €5

This block is used to change the colour of the pen.
If we want to know the working of a particular block in the Script,
then right-click on it and select the Help option.

SAVING A PROJECT
To save a project in Scratch, follow these steps :

B Scratch 2 Offline Editor

Step 1. Click on the File menu.

Step 2. Select the Save option. The Save Project [
dialog box appears.

Step 3. Type the name for your project in the File

name: text box. z
Step 4. Click on the Save button. e
CREATING A NEW PROJECT S
To create a new project, follow these steps : )

Step 1. Click on the File menu.
Step 2. Select the New option.

OPENING AN EXISTING PROJECT
To open an existing project, follow these steps :
Step 1. Click on the File menu.
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& Scratch 2 Offfine Editor

Select the Open option. The Open Project
dialog box appears. =

Select the project you want to open. e SR
Click on the Open button.

The selected project opens in the Scratch window. —— o
EXITING SCRATCH e
To exit Scratch, follow these steps :
Click on the File menu.
Select the Quit option. ¥
Quit op m—

g &8@&% HC{ZIVI =Collaboro{tion

»  Find out how to make the Sprite jump.

J&Zaa@@aaé the G

A programming language has a set of instructions called program, for instructing a computer to
perform specific tasks.

© Sprite is a small graphic character that performs actions in Scratch projects.

© Stage is the main working area where all of the actions take place by the Sprite as per the
given instructions.

©  Scripts area is the place where we write the script for the Sprite.

@@ &.

A. Tick (v) the correct answer :
1. Which of the following is the default Sprite in Scratch?
(a) Dog (b) Mouse (c) Cat
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Which of the following blocks category is used to draw lines on the stage?

(a) Pen (b) Motion (c) Sound
Which of the following is not a block menu?

(a) Motion (b) Pen (c) Move

Which of the following displays your creation?

(a) Stage (b) Script area (c) Block palette

B. Write ‘T’ for true and ‘F’ for false in the given circles :

1.

2.
3.

4.

A programming language has a set of instructions called
program, for instructing a computer to perform specific tasks.

Scripts area is the place where we write the script for the Sprite.

To remove the block from the scripts area, right-click on it and
select Delete option.

On clicking the Green flag, the script will run step-by-step.

C. Fill in the blanks :

L.

is a small graphic character that performs actions in
Scratch projects.

is also called a program.

A is a simple programming language that lets us
create our own interactive stories, animations, games, music and art.

To move or turn the Sprite around through different angles, the
block category is used.

D. Answer the following questions :

1.  What is Scratch?
2. What is the use of Motion and Pen block categories?
3. What do you understand by Script area?
4. What do you mean by Sprite?
_(rea“Vi'ty Ski"S . ﬂ Art Integration

Draw and colour the Sprite on a chart paper.
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_|’r OjEC'l'. Time Practical Skills

Draw the following figures in Scratch :

4 N\
o 4
Experience-based Questions Higher Order Thinking Skills

1. Aarav wants to move the Sprite in backward direction by 50 steps. Can
you help him in completing him task?

2. Nisha's teacher gave her an assignment to draw a square. But, she don't
know how to draw lines on the Stage in Scratch. Help her in completing
the task.

o —

Think & Answer Life Skills & Values

Your friend is unable to move the sprite while programming with Scratch. What
will you do? You will ignore her/him and continue working, or help her/him to
move the Sprite?

Activity Work Cutting & Making Skills

Prepare a chart on ‘Various Components of Scratch’.

[

‘DiSCUSSiOh Communication

Discuss the different Motion category blocks and Pen category blocks in class
in detail.

Teacher's Help

© Tell the students that the Sprite is like your blind folded friend, who needs proper instructions from you to do the
activity. Demonstrate how the Sprite can be instructed to move forward, backward and change directions.
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P More About Scratch
LEARNING

In this chapter, you will learn about :

© Adding New Sprite from Library ©  How to Change the Appearance of Sprite?
© Painting New Sprite O  Sprites that Speak and Think

© How to Make Duplicate Copy of Sprite? O Repeating Actions

© Adding Sound

ADDING NEW SPRITE FROM LIBRARY

Cat is the default Sprite in Scratch. But, we can insert a new Sprite.
To add a new Sprite, follow these steps :

Click on the Choose Sprite | seteu
from library option. | =

The Sprite Library appears.
Select the Category, say

Animals. | w@b ‘% ‘ <3

Select a Sprite of your | ° e b T—
choice. :
Click on OK button. e

) Ursted “ e

The new Sprite will appear on the Stage. It
also gets added to the Sprite list.
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We can hide the previous Sprite from the T
Stage. In the Sprite list, right-click on the F
Sprite we want to hide and select hide = -
option. wse L
HOW TO CHANGE THE APPEARANCE OF SPRITE?

To change the Sprite’s appearance, we can use Costumes. The Looks
category in block menu has instructions to change the appearance of
the Sprite. We can see the different costumes for our Sprite by clicking
the Costumes Tab next to the Scripts Tab. To change the appearance
of the Sprite, follow these steps :

Click on the Costumes tab to display the list of Costumes of
the selected Sprite.

Now, click on the Scripts tab.
Select Motion category of Blocks menu.

Drag this block in the Script area and change its step value
from 10 to 30.

Select Looks category of Blocks menu.

Now, drag these blocks in the Scripts area.

Click on any of the block to run the block stack.
The Sprite will change its colour, size and costume.

Looks Blocks used in the Project

This block is used to change the colour and other

graphic effect on a sprite.

This block is used to switch to the next costume in
the sprite's costume list.

This _plock Is used to change the sprite's size by the
specified amount.
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PAINTING NEW SPRITE

To paint or create your own Sprite, follow these steps :
Click on the Paint l"f‘l'";"’“""'""“‘
New sprite button. =

Use the different :

tools to draw a c A

Sprite. The Paint | > S

Editor window S

opens under the .. — é

Costumes tab. - ® = B o
A new sprite will be added === s

to the Sprite list.

Once we have created the Sprite, we can make duplicate of it,
increase or decrease its size or delete it by using the Sprite toolbar.

Duplicate : It creates another copy of the Sprite.
Delete : It deletes the Sprite.

Grow : It increases the size of the Sprite.

Shrink : It decreases the size of the Sprite.

SPRITES THAT SPEAK AND THINK

A Sprite can say or think in a Scratch [ 7
project. We can make our sprite speak or
think like a character in a comic strip. |

Any phrase we type into these commands

will appear above the Sprite, and the '

message is displayed permanently. If we
want to clear the message, we use a say or
think block with no text.

Let us make a project on it.
Click on the Looks block category in the Blocks menu.
\é\ 69 émputer—fﬁ




Step 2. Click and drag the block on the Scripts area.
Step 3. Click on the Control block category in the Blocks menu.
Step 4. Click and drag the == ... ] on the Scripts area.

Step 5. Again, click on the Looks block category in the Blocks menu.
Step 6. Click and drag the on the Scripts area.

Step /. Type in the message; ‘How are you?’ B===1=3 nside the block.
Step 8. Now, drag the block on the Scripts area.

Step 9. Type in the message; ‘| am fine.’ inside the block.

Step 10. Click on any of the block to run the block stack.

% Serateh 2 Offtine Editer

] untitier ~9

% Scratch 2 Offline Editor

GERME © Fev v Tos Avout

[.-:I' Unfitied = . [I.] Untitled F .

i_l:low are you? i
- After 2 seconds

To Make a Sprite Think
Step 1. Click on the Looks category of Blocks menu.
Step 2. Click and drag it in the Scripts area.
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Type in the message inside the text space of the block.
Click on the block to run the block stack.

% Scratch 2 Offline Editor - O X

E-] Untitled F . Scripts
J riotion E
T |
fsound I
Oh no! | forget my I - fl oee
book in school. ot [
: m Oh no! I forget my book in school,'
O thenic [T for €9 secs
3= oty
*
v 3

Looks Block used in the Project
This block is used to say words in a speech bubble.
This block is used to say words in a speech bubble

D LB for a number of seconds.
It displays words in a thought bubble.

Control Block used in the Project

o This block makes the script wait for specified number
S of seconds and then continues with the next block.

HOW TO MAKE DUPLICATE COPY OF SPRITE?

Let us make a duplicate copy of the sprite.
Click on the Pen block category in the blocks menu.
Click and drag the block on the Scripts area.

Click and drag the , and EZEEEEEETO block on
the Scripts area. Then, set the pen size from 1 to 10.

Click on the Motion block category in the Blocks menu.

Click and drag the BZ:=E=3 on the Scripts area. Then, change
the step value from 1 to 50.
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Step 6. Click and drag the block on the Scripts area.
Step /. Click on any of the block in the scripts area to run the block stack.

& Scratch 2 Offline Editor - o X

E-] Untitled F . Scripts Costumes Sounds

l Ind I sing
set pen size to m
it & . change pen color by
t Mouse- polnber

move @ steps

if on edge, bounce

Pen Block used in the Project

This block is used to create a duplicate copy of the
Sprite.

Motion Block used in the Project

i on vdge, bounce This block is used to turn the Sprite in the opposite
- direction if it touches the edge of the stage.

REPEATING ACTIONS

r— 10 |
, Block

The Repeat block of the Control category of the Blocks menu is used
to repeat the actions of the sprite as many times as needed. This
block runs the blocks inside it a specified number of times. The
Repeat instructions control the execution of the program.

Let us make a project on it.
Step 1. Click on the Control block category in the Blocks menu.

Step 2. Click and drag the =~ w;,, block on the Scripts area.
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Step 3. Click on the Pen control category in the Blocks menu.

Step 4. Click and drag the , BEEE) and B89 block on the
Scripts area. Then, set the pen size from 1 to 10.

Step 5. Click on the Motion control =seeme. _——
category in the Blocks = ~e =
menu. i i
. T |
Step 6. Click and drag the g
and (piEI=T .. .
?Ir:)ck onhthe SC’EIhptS atrea. "'““‘
en, change e Steps | .. L= e
value from 1 to 30 and =/za =D s

turning value from 15to 10.
Step /. Click on any block to run a block stack.

Block

This block of the Events category in the Blocks menu is very useful.
When this block is on the top of a block stack, the actions of the block
get executed when the green flag |m~| on the top-right corner of the
stage is clicked.

S Block -
This block of the Control
category runs the blocks inside
it over and over again, unless
the Stop button |®| on the top-
right corner of the stage is
clicked.

ADDING SOUND

Sound block has instructions to make the Sprite speak, add musical
notes, etc. Let us make a project on it.
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Step 1.
Step 2.
Step 3.
Step 4.
Step 5.

Step 6.
Step 7.
Step 8.
Step 9.

Click on the Control block category :[
in the blocks menu.

Click and drag the " ““* block on |
. ot
the Scripts area. |

Click on the Looks block category : —
in the blocks menu. |

| b, ot
Click and drag the and | |
IR block on the Scripts area. i

Click on the Motion block category ==
in the blocks menu.

Click and drag the block on the Scripts area.
Click on the Sound block category in the Blocks menu.
Click and drag the block on the Scripts area.
Click on the Control block category in the Blocks menu.

Step 10. Click and drag the = .21 block on the Scripts area.

Step 11.

Click on the Sound block category in the Blocks menu.

Step 12. Click and drag the block on the Scripts area.
Step 13. Click on any of the blocks to run the block stacks.

% Scratch 2 Offline Editor — O >

el ; Scripts Costumes
™, Uniitled ~ o

- change color effect by ED

move EB) steps

| play drum G for beats
R
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Sound Blocks used in the Project
This block is used to play the specified sound and

continues to the next block immediately.
This block plays a drum sound for a specified
number of beats. Click on the drum type by clicking

the drop-down arrow next to the number and the
number of beats by changing the value in the box.

= Chacnlepyy Activity Slldbortion

»  Find out if we can add more than one sprite on a stage.

Jeacoa&ct the (G

Cat is the default Sprite in Scratch. But, we can insert a new Sprite.

© A Sprite can say or think in a Scratch project. We can make our sprite speak or think like a
character in a comic strip.

© The Repeat block of the Control category of the Blocks menu is used to repeat the actions of
the sprite as many times as needed. This block runs the blocks inside it a specified number of
times. The Repeat instructions control the execution of the program.

© The . block runs the blocks inside it over and over again, unless the Stop button [ ®]on
the top-right corner of the stage is clicked.

©  Sound block has instructions to make the Sprite speak, add musical notes, etc.

A. Tick (V) the correct answer :
1. Which of the following blocks is not belonged to Looks category?

(a) (b) (c)
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Which of the following blocks displays words in a thought bubble?

(a) (YN --v [T or © secs (c)
Which of the following blocks is not belonged to Control category?

(@) (b) == (c) ' ,'l

R |

Which of the following block controls the looks of tHe s'prite?
(a) Looks (b) Control (c) Motion

Write ‘T’ for true and ‘F’ for false in the given circles :

1.
2.
3.

4.

The Repeat instructions control the execution of the program.
Cat is the only Sprite in Scratch.

Sound block has instructions to make the Sprite speak, add
musical notes, etc.

We cannot paint a sprite in Scratch.

Fill in the blanks :

1.
2.

3.
4.

To change the Sprite's appearance, we can use :
block is used to create a duplicate copy of the

Sprite.
A is the default Sprite in Scratch.
The category in block menu has instructions to

change the appearance of the Sprite.

Write down the uses of the following blocks :

L.
2.
3.

i stk

4. CY=TES

Answer the following questions :

1.

2.
3.
4.

What is the difference between =~ and = blocks?
What is the use of Forever block?

What is the use of next costume block?

Name the blocks used to play the sound of a sprite?
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=(r ea'!:iVﬂ:H Sl(i"S ] ﬂ Art Integration

2

Draw and colour any two Sprites of the Scratch on a chart paper.

_|’r OjCC'l: Ti Me Practical Skills

Drag the following blocks in the scripts area and observe the changes.

Experience-Based Questions Higher Order Thinking Skills

1.  Piyush wants to make a duplicate copy of the Sprite. Can you help him in
completing his task?

2. Abhishek wants to play a drum sound for a specified number of beats.
Suggest him an appropriate block to complete his task.

Think & Answer Life Skills & Values |

Your teacher gives you a project in Scratch and you are unable to do it. What
will you do- ask a friend to complete it for you or try to do it again and if
unsuccessful, ask with your teacher?

*—

Activity Work Cutting & Making Skills

Draw and colour the different Sprites on a chart paper. Also, explain the
different blocks you have studied in this chapter.

_Discussion Communication \

Discuss the different repeating actions in class in detail.

Teacher's Help

© Ask the students if they want a different Sprite. Show them how to get the new Sprite or create a Sprite using
the Paint editor.
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Artificial
Intelligence

Alexa

Alexa is Amazon’'s all-knowing,
interactive voice assistant. Alexa can
do quick maths for us, launch our
favorite playlists, check news and
weather, and control many of our
home’s smart products.

Alexa is a voice that we can ask
questions to and get answers, such
as “What is the weather today in
India?”. Alexa has been integrated into many of Amazon’s services and
can be used with products such as original Amazon Echo, Echo Dat,
Echo Spot, or Amazon Fire TV.

But really, what exactly is Alexa? When we ask Alexa a question, what
we're doing is communicating with a cloud-based service. Amazon
has designed the Alexa Voice Service (AVS) to mimic real
conversations, but we're actually using intuitive voice commands to
get this service to perform specific tasks. “Alexa” is simply the “wake
word” that alerts the service to start listening to our voice. For most
devices, we just have to say the wake word to get a response.

Alexa has also become the center of many smart-home systems,
including Wink and Smart things.
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& ol fog =P
Model Test Paper-

A. Tick (v) the correct answer :
1. Which of the following is not an input device?

(a) BCR (b) Biometric sensor (c) Projector
2. A is a collection of data.

(a) Folder (b) Icon (c) File
3.  Which of the following is displayed just below the title bar?

(a) Work area (b) Status bar (c) Ribbon
4. is the area where we draw in Paint 3D.

(a) Text (b) Title Bar (c) Canvas

B. Write ‘T’ for true and ‘F’ for false in the given circles :
1.  Software means the physical parts of the computer that we can touch or feel.
2.  An operating system tells a computer how to work.
3.  The Ruler makes easier to adjust our document with precision.
4.  We can draw both 2D and 3D shapes in Paint 3D.

C. Fill in the blanks :

1. A can be used in place of a mouse.

2. Windows 10 has a new search tool called :

3. The button reduces a window to a small icon on the taskbar.
4, is used to add text.

D. Answer the following questions :
1. What is the role of ports and SMPS inside the CPU of a computer system?
2. Write any two features of Windows 10.
3. How many scroll bars are there in Word 20197 Name them.
4.  What is the use of Sphere and Cylinder tools?

E. Draw and colour the logo of Windows 10 in the given space :
4 )
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Model Test Paper-

A. Tick (v) the correct answer :
1. Which of the following panes is used to type commands?

(a) Inspector (b) Editor (c) Canvas

2. Which of the following blocks category is used to draw lines on the stage?
(a) Pen (b) Motion (c) Sound

3.  Which of the following is not a block menu?
(a) Motion (b) Pen (c) Move

4.  Which of the following block controls the looks of the sprite?
(a) Looks (b) Control (c) Motion

B. Write ‘T’ for true and ‘F’ for false in the given circles :
1. kturtle is the extension of the KTurtle file.

2.  Scripts area is the place where we write the script for the Sprite.
3. The Repeat instructions control the execution of the program.
4.  Catis the only Sprite in Scratch.

C. Fill in the blanks :

1. The command is used to hide the turtle from the canvas.
2. is also called a program.

3. block is used to create a duplicate copy of the Sprite.
4, A is the default Sprite in Scratch.

D. Answer the following questions :
1. Name the commands use to change the colour and size of the pen.
2.  What is the difference between reset and clean commands?
3.  What do you mean by Sprite?
4.  What is the use of next costume block?

E. Write down the uses of the following blocks :
1.

R

2.
3.
4,

E=1'8 Hello! forosecs
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